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SUMMARY: 
This article introduces a simple one-pot reconstitution of cytoskeletal networks inside phase separated giant vesicles. The method can be generalized and applied to encapsulation or confinement of a wide range of biomolecules. 

ABSTRACT: 
Biomimetic lipid membranes in the form of giant unilamellar vesicles (GUVs) are commonly used to mimic cellular membrane behavior because of the ease of protein reconstitution inside GUVs, visualization, as well as understanding cellular membrane-protein dynamics. However, cell membranes comprise lipid rafts (or domains) arising from the presence of different lipids in the cellular membrane. Such increased complexity in model systems can be incorporated to result into phase separated GUVs, where lipid composition can be finely tuned. While encapsulation methods for the generation of homogeneous GUVs are widely known, methods to encapsulate proteins within phase separated GUVs are limited. Here, this protocol presents a simplified one-pot production of phase separated GUVs, comprised of liquid-disordered (Ld) and liquid ordered (Lo) domains, efficiently encapsulating different cytoskeletal proteins, i.e., FtsZ and actin, making the method a versatile tool for minimal cell production. Specifically, this approach uses an emulsion transfer protocol to produce GUVs with a high encapsulation efficiency. In this method, a lipid-monolayer is first generated by emulsifying a protein solution in a lipid/oil mixture, where lipids of varying phase transition temperatures are chosen to yield phase separation in the resultant GUVs. This emulsion is transferred gently on top of a lipid-in-oil solution in another tube, resulting in the formation of a water-oil interface. The solution is then centrifuged at elevated temperatures (ideally at 37 °C to retain protein activity), after which GUVs are collected for imaging. This method simplifies the in vitro reconstitution of cytoskeletal proteins within phase separated GUVs without using a cumbersome laboratory setup, and thus serves as a convenient method for studying the mechanics of cytoskeletal-membrane interactions in confinement.  

INTRODUCTION:
Giant vesicles serve as model systems to understand cellular functions1,2. Their ease of production, visualization, tunability, and in vitro reconstitution of biomolecules make these biomimetic models the system of choice for many research studies3–5. There are several known methods to make GUVs, such as electroformation6, cDICE7,8, emulsion transfer, and other microfluidic-based methods9,10. GUV production with such methods is reported in the literature3,11. Moreover, in vitro, reconstitution of cytoskeletal networks inside GUVs has been previously described using an emulsion transfer method due to the ease of this one-pot formation method, which does not require any complex setup12. However, such reconstitution is reported very commonly in homogeneous GUVs, a system that does not fully mimic the complexity of cellular membranes.

This protocol describes the in vitro reconstitution of cytoskeletal networks inside phase separated GUVs, exhibiting the complexity of the lipid membrane. While such networks have been previously reported to bind on the surface of the membrane (outside) but not confined within the giant vesicles13,14, the present emulsion transfer technique focuses on the protocol to yield phase separation, as well as retain the activity of the network formation of the cytoskeleton. One of the major challenges in this technique is temperature. Standard production methods to generate phase separated GUVs require the use of elevated temperatures, which vary depending on the phase transition temperature of the constituent lipids. However, cytoskeletal proteins are unable to polymerize into higher-order structures at such high temperatures15–17. Thus, this protocol not only employs a lipid composition to yield phase separation in GUVs at room temperature but also optimizes the conditions to produce a good yield of GUVs at physiological temperatures.

Another aspect for consideration while producing reconstituted GUV systems is the volume of the encapsulated biomolecules required. For most proteins, producing higher volumes can be expensive and time-consuming, involving several purification rounds. Moreover, in vitro reconstitution experiments generally necessitate an initial exploratory phase where the biomolecule concentrations, buffer compositions, etc., are first tested to achieve an optimized inner solution content. Thus, this protocol optimizes the GUV production protocol for two different assays, which adapt to the aforementioned premises. On the one hand, this protocol describes one assay that optimizes the standard inverted emulsion protocol, which involves relatively higher volumes of proteins and generates high-yield GUV production in tubes, which are later transferred to imaging 96-well plates. On the other hand, the approach described here also optimizes the protocol for phase-separated GUV production directly in imaging well plates, which employs lower volumes of biomolecules (~1/4 of the amounts required for production in tubes) and enables GUV generation in series, achieving many encapsulated conditions in one centrifugation step. Thus, the protocol presented here shows one encapsulation method but allows the user to choose either setup based on their requirements. 

Moreover, this protocol describes an optimized method for encapsulation for two different cytoskeletal networks: FtsZ and actin. Since these two proteins require different buffer and crowding conditions, the protocol addresses the subsequent necessary changes to achieve optimal network reconstitution. Therefore, the approach presented here can be used and generalized for encapsulating any required biomolecules within phase separated GUVs.

PROTOCOL:
The reagents and the equipment used in this study are listed in the Table of Materials.

1. Lipid mixture preparation

1.1. Take 0.5 mL of chloroform in a 5 mL glass vial. Add 17.5 µL DOPC, 7.4 µL DOPG, 29.6 µL DPPC (all from 25 g/L lipid stocks prepared in chloroform), 32.2 µL of 10 g/L DPPG and 20.6 µL of 18 g/L Cholesterol. Add 1.2 µL of 1 g/L Atto655-DOPE dye. Gently vortex the lipid mix and, evaporate the chloroform under Nitrogen flow and re-suspend the thin film in a total of 400 µL chloroform. 

1.2.  For the encapsulation of FtsZ, the final lipid mix prepared is in the ratio DOPC: DOPG: DPPC: DPPG: Chol (17.499: 7.5: 31.5: 13.5: 30 mol ratio) labeled with 0.001 mol% Atto655-DOPE. For the production of GUVs with encapsulated bundled-actin, the lipid mix contains biotinylated lipids, and it is prepared in the ratio DOPC: DOPG: DPPC: DPPG: Chol: Biotinyl CAP PE (17.499: 7.5: 30.5: 13.5: 30: 1) labeled with 0.001 mol% Atto655-DOPE.

1.3. [bookmark: _GoBack] Dissolve the lipid mix (32 mM, 50 µL) in chloroform and dry in a glass vial under N2 gas flow for ~15 min. 

1.4.  The glass vial is then stored under vacuum in a desiccator for ~30 min to get rid of any traces of residual chloroform. 

1.5.  Disperse the dried film in a mixture of decane (20 µL) and mineral oil (500 µL) in the glass vial to yield the final concentration of 3.2 mM and sonicate at elevated temperatures (~50 ˚C) for ~30 min using a bath sonicator.

1.6.  Transfer the lipid-in-oil mix to a tube and incubate the tube at 37 °C for ~10 min before proceeding to the next steps.

1.7. Prepare the inner encapsulation mix for proteins.

2. Preparation of inner solutions for encapsulation

2.1 	FtsZ filament mixture
2.1.1	 Prepare the FtsZ protein mixture in a total volume of 10 µL in a microtube. For the FtsZ filamentous network, add 0.87 µL of 23 µM FtsZ-YFP-mts, 1.31 µL of 381 g/L Ficoll70, 1.11 µL of 271 g/L BSA, and 1 µL of 25 mM GTP to 5.71 µL FtsZ reaction buffer (RB). The total volume of the solution is 10 µL containing 2 µM FtsZ-YFP-mts, 50 g/L Ficoll70, 30 g/L BSA, and 2.5 mM GTP in the final solution. Keep it on ice before using it for encapsulation within GUVs.

NOTE: FtsZ reaction buffer (RB) contains 50 mM Tris-HCl, pH 7.5, 150 mM GluK, 5 mM GluMg.

2.2 Actin-bundle mixture

2.2.1 	For the encapsulation of actin bundles, first prepare a 10 µL actin master mix (A-Mix) containing 86% G-actin, 10% Atto488-actin, and 4% biotinylated actin in water. For this step, prepare protein stock solutions according to the manufacturer's instructions. Then, for a final concentration of 35.42 µM A-Mix, add 6.39 µ L of 2 g/L G-actin, 1.48 µL of 1 g/L Atto488-actin, 1.19 µL of 0.5 g/L biotinylated actin, and 0.9 µL H2O. Keep on ice and cover from light.

2.2.2	 To prevent pre-polymerization and bundling of actin outside of the GUVs, prepare the final actin solution minutes before encapsulation. The final solution consists of 7% Iodixanol, 0.01 g/L Neutravidin, 2.4 µM A-Mix, 0.6 µM Fascin, 10 g/L BSA, 20 g/L Ficoll70, and 5 mM ATP in actin polymerization buffer. 

2.2.2.1 To prepare this final solution, which must be kept on ice at all times, add in the following order: 2.92 µL of 60% Iodixanol, 10.25 µL H2O, 2.5 µL of 0.1 g/L Neutravidin, 0.92 µL of 271 g/L BSA, 1.31 µL of 381 g/L Ficoll70, 2.5 µL of 10x Actin Polymerization buffer, 1.69 µL of 35.42 µM A-Mix, 1.65 µL of 9 µM Fascin, and 1.25 µL of 100 mM ATP. Mix well and quickly take the 5 µL needed to encapsulate. 

NOTE: measure the osmolarity of this inner solution with an osmometer (~430 mOsm/Kg). A matching outer solution mixed with the same osmolarity must be prepared by diluting glucose in water until reaching the same osmolarity value (see step 3.2). 10x Actin polymerization buffer contains 100 mM Tris-HCl, pH 7.5, 500 mM KCl, and 50 mM MgCl2.

3. GUV production and in vitro encapsulation 

3.1 	GUV production in tubes: encapsulation of FtsZ

3.1.1 	For FtsZ encapsulation, add 500 µL of FtsZ reaction buffer (RB) in a 1.5 mL plastic tube and gently add 200 µL lipid-in-oil mix (prepared in step 1.6 above) to allow the formation of an oil-water interface and the deposition of a lipid monolayer at this interface.

3.1.2 	To form the emulsion, first take another 1.5 mL tube and add 200 µL lipid-in-oil. Incubate this tube at 37 °C for ~10 min before forming the emulsion.

3.1.3 	Once incubated, add 5 µL of the FtsZ protein mix (prepared in 2.1.1) to this tube. The 5 µL protein in aqueous media sinks to the bottom of the tube as a droplet. 

3.1.4 	Make an emulsion by gently tapping on the bottom of the tube 5–6 times until the solution becomes visibly turbid.

3.1.5 	Gently pipette this emulsion and place it on top of the oil-water interface (prepared in step 3.1.1 above). 

3.1.6 	Centrifuge this at 6000 x g for 30 min at a preheated temperature of 37 °C and maintain this temperature until the end of the vesicle production. 

3.1.7 	Allow the sample to cool to room temperature for nearly 30 min before imaging.

3.1.8 	Remove the top layer of oil by gently pipetting from the top of tube, leaving nearly 100–200 µL solution for imaging.

3.1.9 	Cut a pipette tip at an inclined angle with scissors and gently pick up 50–100 µL of the GUV solution from the bottom of the tube. This solution will be used for imaging. 

3.2 	GUV production directly in 96-well plates: encapsulation of actin

3.2.1 	For actin encapsulation, first prepare an outer solution mix (glucose in water) with the same osmolarity as the inner actin mix. To match the ~430 mOsm/Kg of the inner mix, make an outer solution mix by adding 198 µL of 2 M glucose in 802 µL H2O.

3.2.2 	To make the vesicles directly on a well plate, first passivate one well of a 96-well plate. Add 100 µL of 10 g/L BSA in the well and incubate for 10–15 min. Then, wash the well with 100 µL outer solution five times with care not to touch the passivated glass bottom with the pipette tip. Leave 100 µL of the outer solution mix in the well after completing the washing.

3.2.3 	Gently add 50 µL lipid-in-oil mix to the well to prepare the lipid monolayer on top of the outer solution. To ensure a correct deposition of the oil on top of the aqueous phase, rest the pipette tip on one side of the well and let the oil slide from the wall of the well.

3.2.4 	To form the emulsion, first take a 1.5 mL tube and add 100 µL lipid-in-oil. Incubate this tube at 37 °C for ~10 min before forming the emulsion.

3.2.5 	Add 2.5 µL of the final actin solution (from step 2.2.2) to the tube containing 100 µL lipid-in-oil mix (step 1.6 above). The 2.5 µL protein in aqueous media sinks to the bottom of the tube as a droplet. 

3.2.6 	Make an emulsion by gently tapping on the bottom of the tube 10–20 times until the solution becomes visibly turbid.

3.2.7 	Gently pipette this emulsion and place it on top of the oil-water interface (prepared in step 3.2.3 above). Submerge the tip of the pipette carefully in the middle of the oil monolayer and deposit the emulsion. The emulsion forms a turbid cloud confined in the oil monolayer phase.

3.2.8 	Centrifuge the 96-well plate at 200 x g for 20 min at a preheated temperature of 37 °C and maintain this temperature until the end of the vesicle production. 

NOTE: Centrifuge at 400 x g for 10 min to shorten vesicle production time. However, stick to these centrifugation parameters for best results. Centrifugation above 400 x g results in compacted vesicles with lipid aggregates accumulating at the bottom of the imaging plate.

3.2.9 	Allow the sample to cool to room temperature for nearly 30 min before imaging.

NOTE: Direct imaging can be performed on a well without the need to remove the top layer of oil or transfer the vesicles to another chamber/well.

4. Imaging and 3D image reconstruction

4.1.  Take a 96 imaging well plate and passivate it with BSA for ~10 min before transferring the sample to the imaging well plate (see step 3.2.2). 

4.2.  Transfer the GUV solution to the passivated well plate. 

4.3.  Set up the well plate on the stage of an inverted confocal microscope on a 40x water objective. 

4.4.  Focus on any region of interest (ROI) and take a z-stack image sequence from the chosen ROI with fixed z-step intervals. The protocol results in 5–30 µm sized GUVs, so the interval can be fixed to 0.5–1 µm, as required.

4.5.  Save each z-stack image sequence in .tiff format. 

4.6.  Open an image sequence of interest in an image processing software (ImageJ/Fiji). Identify the image with the highest intensity. Hold ctrl+shift+c to open the Brightness & Contrast window and click on Auto.

4.7.  From the ImageJ/Fiji menu, go to Analyze > Set Scale and enter the known physical distance and its unit for each image pixel.

4.8.  From the ImageJ/Fiji menu, go to Image > Stacks > Z project to reconstruct a 3D image from the z-stack. Set the Projection type as Standard Deviation. The default options can be used for the rest of the settings (Start slice and Stop slice).

NOTE: beware of standard deviation projection artifacts arising from overlapping z-stacks in 3D reconstruction. To ensure that there are no artifacts, remove z-stacks in the bottom hemisphere of the sphere to only observe the top half projection.

5. Statistical analysis of GUV frequency based on size

5.1 Acquire Z-stack images of the GUVs of interest, as explained in steps 4.4 and 4.5. To image as many GUVs as possible in a wide field of view, acquire confocal stacks at 1x or 2x zoom. 

5.2 Open the Z-stack sequences in an image processing software (in this case, ImageJ/Fiji), as explained in 4.6. 

5.3 Select the display channel where the membrane fluorescence signal was acquired by clicking on the bar labeled as c underneath the image. Adjust the Brightness and contrast of the image as explained in 4.6.

5.4 Navigate through the different planes acquired by clicking on the z bar underneath the open image. Select the plane where the diameter of the vesicle to be analyzed is the biggest.

5.5 Open the ROI manager in ImageJ/Fiji by clicking on Analyze > Tools > ROI Manager.

5.6 From the tools available in the ImageJ/Fiji main panel, click on the oval selection.

5.7 Draw a circle that fits the GUV by following the fluorescence intensity of the GUV membrane. To draw a circle selection, press the shift key and drag the mouse to expand the circle up to the size of the vesicle. The circle selection can be moved by simultaneously clicking the left mouse button on the center of the vesicle and dragging the mouse to the desired location.

5.8 Store the circle selection drawn in the ROI Manager by clicking on Add [t], located on the options panel of the ROI Manager.

5.9 To obtain the size of the vesicle in microns, click on Measure located on the panel of the ROI Manager. A new window will pop up. Take the value displayed at the Major or Minor column (both columns must have the same value as they refer to ellipse axes) as the measurement for the vesicle diameter.

5.10 Use plotting software (Excel, Origin, Prism) to create a bar graph where the fraction of GUVs for different size ranges is specified.

REPRESENTATIVE RESULTS:
As a first step, GUVs with membrane phase separation were produced following a modified inverted emulsion approach (Figure 1A). This results in a high yield of GUVs, which exhibit a membrane demixed into Ld and Lo domains, as represented by the Atto 655-DOPE label on the Ld domain and dark regions corresponding to unlabeled Lo domains (Figure 1B). This method yields phase-separated GUVs of sizes ranging from 5–30 µm (Figure 1C) at elevated temperatures (all steps performed at 37 °C and imaged at RT). Moreover, centrifugation speeds were adjusted to ensure the incorporation of the original component lipids within GUVs as well as to avoid excessive overpopulation.  

Furthermore, to demonstrate the successful encapsulation of biomolecules using the emulsion method described in the current protocol, both FtsZ and actin networks were reconstituted in individual experiments. FtsZ networks are recapitulated inside GUVs, which emerge as filaments preferentially binding to Ld domains via their membrane targeting sequence (MTS) in the presence of 2.5 mM GTP and 50 g/L Ficoll70 (as depicted in Figure 2). The networks were observed approximately 1 h after the encapsulation step. However, actomyosin networks emerge as thin bundles (in contrast to thick networks of FtsZ) after reconstitution within GUVs (Figure 3). It must be noted that biotinylated lipids play a crucial role in the binding of the actomyosin networks to the membrane of the GUVs. Without biotinylated lipids, actomyosin bundles cannot adopt a curved configuration and remain as straight, short, and stiff bundles at the lumen instead of adhering to the membrane as an entangled mesh of long bundles (Figure 4). 
 
In the modified emulsion protocol, centrifugation speed is adjusted to obtain phase separated GUVs, as mentioned earlier. Indeed, higher centrifugation speeds with samples containing actomyosin networks (600 x g for 15 min) result in the aggregation of vesicles into a tissue-like configuration inside the production well. Thus, in all standard reconstitution experiments of actomyosin networks, the optimal centrifugation speed was set to 200 x g to obtain non-aggregated GUVs (Figure 5). 

FIGURE LEGENDS:

Figure 1: One-pot generation of phase separated GUVs employing the double emulsion transfer method. (A) Experimental scheme of the key steps in the one-pot production of phase separated vesicles via double emulsion transfer. (B) Confocal Z-projection image of the resulting GUVs generated following the method described in A. Scale bar is 50 µm. (C) Bar graph with the fraction of phase-separated GUVs generated according to their diameter. Experiments performed n = 3, the total number of GUVs analyzed per experiment = 100. Data shown as mean values, individual data points are the three independent experiments. Error bars represent the standard deviation of the three experiments.

Figure 2: Phase-separated vesicles with encapsulated FtsZ networks. (A) Confocal 3D projection images performed on a fully acquired z-stack of a phase separated GUV containing a FtsZ network. (B) Confocal Z-projection images performed on only the top half of the vesicle. Due to the heterogenous formation of domains over the surface of the GUV, the 3D reconstruction of the acquired confocal slices shows the overlapping of lipid domains from the top and bottom areas of the vesicle. To prevent overlapping and facilitate the visual inspection of the domains, the bottom half of the z-stacks acquired are removed from the file. The resultant top half is then used for its 3D projection via standard deviation. Scale bars are both 20 µm. 

Figure 3: Phase-separated vesicles with encapsulated actomyosin networks. (A) Confocal Z-projection images of an entire acquired stack with a zoom-out view of the well after vesicle production. The high yield of vesicles obtained allows the study of different actomyosin structures within the vesicles. The scale bar is 50 µm. (B) Confocal Z-projection images performed on the top half of a vesicle. To facilitate the visual analysis of lipid domains, only the top half of image slices are used to perform a 3D projection. The scale bar is 10 µm.

Figure 4: Importance of biotinylated lipids for the generation of membrane-bound actomyosin networks inside phase separated vesicles. Confocal 3D projections depicting phase separated vesicles with non-attached actomyosin networks. If biotin lipids are not incorporated into the mix, actomyosin structures form at the lumen and do not acquire a curved configuration on the inner leaflet of vesicles (right panel, actin labelled with Atto488). Scale bar is 50 µm.

Figure 5: Effect of centrifugation speed on the production of phase separated vesicles via emulsion transfer. Confocal 2D images showing a GUV sample generated by employing a centrifugation force of 600 x g for 15 min. The centrifugation speed employed, higher than the optimized 200 x g, results in the aggregation of vesicles into a tissue-like configuration inside the well. The scale bar is 100 µm.

DISCUSSION:
One of the major challenges for in vitro reconstitution of membrane-based model systems is the encapsulation of proteins inside phase separated GUVs owing to their preparation at high temperatures. Indeed, the generation of this type of phase separated vesicles via one-pot synthesis can lead to difficulties arising from the degradation of proteins at elevated temperatures. Thus, this protocol describes the optimized conditions to observe membrane phase separation following the double emulsion method for GUV production at physiological temperatures, while simultaneously maintaining the activity of the encapsulated proteins. This approach introduces a negative charge to both domains to facilitate the binding of any desired proteins when electrostatic interactions are a prerequisite. In the case of encapsulation of FtsZ, despite the presence of negative charge in both domains, the cytoskeletal networks develop and bind preferentially to Ld domains, indicating that along with negative charge, fluidity of the membrane is an essential requirement for protein binding18. Furthermore, in the case of actin encapsulation, the networks develop over membrane regions where biotinylated lipids are incorporated19.  

Although the emulsion transfer assay is widely used in literature, it has only been applied to the production of homogeneous GUVs. This protocol, therefore, consists of several modified aspects of the assay, which allow for the observation of domain formation in the membrane. One of the major aspects in this regard is temperature. To observe domains, as well as to maintain the functionality of the proteins (specifically cytoskeletal network formation), this protocol employs 37 °C to produce GUVs. On the one hand, when GUVs are produced at a higher temperature, the encapsulated proteins lose their functionality, residing in the lumen and not polymerizing into higher-order structures. On the other hand, if GUVs are produced at a lower temperature, phase separation is not observed in the membrane. Thus, 37 °C becomes the optimal temperature for GUV production in the experiments.
 
It is important to note that this protocol provides two possible assay systems to produce GUVS following the same emulsion transfer principle: within tubes and well plates. Both present advantages and disadvantages, which the user may need to take into account during the experimental planning phase to determine which system best fits their needs. Indeed, plastic tubes do not require a centrifuge equipped with a rotor for well plates, they are easier to handle, and allow control over the dilution factor of the vesicles after production and before imaging. However, they require higher volumes (for both oil and aqueous phases) and removal of the oil layer after production for GUV extraction, which may leave oil remnants in the imaging well if this step is not carefully performed. Alternatively, well plates require the use of less sample volume, allow the encapsulation of different inner conditions in series and at once, and do not require GUV extraction, as vesicles can be imaged straight after production in the same production well. The main disadvantage of well plates is the aggregation of vesicles and the need to adjust centrifugation parameters to reach a similar vesicle production yield to that observed in tubes.
 
Independently of the encapsulation system employed (tubes or well plates), this approach shows that optimal crowding conditions are required to produce the GUVs, as well as to facilitate the polymerization of encapsulated proteins. In particular, following this protocol, the best condition for GUVs with encapsulated FtsZ was observed with 30 g/L BSA and 50 g/L Ficoll7018; whereas for actin, a mixture of 10 g/L BSA, 7% Iodixanol, and 20 g/L Ficoll70 was required19. 

Another important aspect of GUV production is the centrifugation speed and time. For the formation of FtsZ networks under the above-mentioned crowding concentrations, centrifuging at 6000 x g for 30 min renders a population of GUVs that are well distributed and separated over the imaging well plate. Conversely, for actin, 200 x g for 20 min enables the generation of a high GUV production yield. If the centrifugation speed or time is decreased, the yield of GUVs is affected, whereas increasing it above the said values leads to aggregation of GUVs. Under the said conditions, this protocol generates GUVs with maximum encapsulation efficiency as well as individual GUVs not sticking together. 

While this protocol can be generalized to any lipids and encapsulated biomolecules, the desired membrane composition and the contents of the vesicles dictate the centrifugation parameters, which allow the generation of phase-separated vesicles. Therefore, this protocol serves as a guideline to enable the production of diverse vesicles with membrane domains.

Such methodologies of in vitro reconstitution within phase separated GUVs are crucial to comprehend intricate protein-membrane dynamics mediated through lipid domains, while considering the complexity of the cell membranes14. The small size and highly dynamic nature of these lipid domains make the characterization of interfacial interactions difficult in vivo. Hence, GUVs serve as a vital tool due to their relative ease of preparation and physical-chemical modulation, as well as their suitability for analysis by light microscopy20. 
In addition, the encapsulation of functional molecules within heterogeneous biointerfaces presents promising applications in the field of nanomedicine. In particular, the development of functionalized drug delivery systems with different properties arising from the asymmetric distribution and partitioning of biomolecules into confined areas on their surface21. Drug-lipid interactions play a significant role in the pharmacokinetic properties of drugs, such as their transport, distribution, and accumulation, which ultimately influence the efficacy of the drugs used22. Therefore, understanding the role of these interactions on the pharmacokinetic properties of drugs is critical in developing effective drugs. Model lipid membranes can be explored to understand their mechanisms of interactions with peptides, polymers, and nanocarriers23. Thus, changes in the lipid composition of cells and tissue in certain disease conditions may alter biophysical interactions, which could be explored to develop target-specific drugs and drug delivery systems24. 

In conclusion, the protocol described here provides a facile strategy to generate phase separated GUVs with encapsulated proteins anchored to their inner lipid leaflet. The generation of these vesicular systems holds promising use in fields like biotechnology and synthetic biology, where multicomponent assemblies with complex functionalities to mimic cell-like functions might bring innovative solutions and new applications. 
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